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Teachers Guide to Kit 6:  
Technology and Other Good Ideas 
 
This kit focuses on Assistive Technology for people who are living with a disability, especially a 
vision disability.  
 
It offers direct relevance for the English, Technology and Enterprise and Society and Enterprise 
Learning Areas as well as indirect relevance to Science, LOTE and Mathematics.   
 
In this guide: 
 

• Key Messages & Learnings  
• Quick Overview of Provided Activities 
• Other Suggested Learning Activities 
• Background Reference Information 
• Useful Websites 
• Curriculum and Outcomes Information 

 
Key Messages & Learnings in this module: 
 

1. When we design and use any technology we think about how people will use it, and in 
doing so, we make assumptions about people’s abilities. But there are not many abilities 
that are common to all humans. If we design and create something that assumes an 
ability that not everyone has, we create a barrier to those people’s participation. In a very 
real sense, we often make a disability much more of a problem than it needs to be.  

 
2. For most people, vision is the dominant source of information. This has had a huge 

influence on the way humans have always designed and used technology. But technology 
designed to use vision can pose problems for people living with some degree of vision 
impairment. 

 
3. Computers, the internet, movies and television are examples of very popular and 

important technologies of modern life but they can be challenging for anyone living with 
vision or hearing impairment. 

 
4. Rethinking the way we design, create and use technology can make a big difference to 

people’s lives. 
 
Food for Thought:  Technology Proves a Point 
Education, training and employment have long been among the most difficult challenges facing 
people with a disability. Access to education and training has improved dramatically in recent 
decades but this has not yet translated to significant improvements in employment outcomes. 

Disability is strongly linked to poverty and ill-health, not only for the person who has a disability 
but also their families. This impacts on the prosperity and wellbeing of their entire communities. 

But recent progresses in technology show how the right tools can help rather than hinder people 
with disabilities - unlocking what they can do. When we get technology right, it can open up 
possibilities that benefit everyone.
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Quick Overview of the Provided Activities  
 
6.1 New & Improved 
This exercise engages students in an innovation-based process of reconsidering a common 
invention in the context of vision impairment. A worksheet, which focuses on vision 
impairment, is provided but you can adapt the concept to any other form of disability or 
indeed allow students to choose which disability they will refer to. 
 
6.2 Double Bonus Ideas 
This is a straightforward worksheet-based activity designed to reinforce the philosophy 
behind the concept of Universal Design; not only that buildings, products and services should 
be designed to maximise the number of people who can access them, but also to maximise 
the ways in which these people can access them and the benefits they can derive. It is based 
on the belief that accessible design helps everyone, not just those who have a disability. 
 
6.3 Simulated Surfing 
This hands-on activity reinforces understandings and knowledge about the variety of eye 
conditions and vision impairments (refer to Kit 2) but does so with specific reference to 
assistive technology. The core components are construction (by either the teacher or the 
students) of a set of ‘spectacles’ which simulate different kinds of vision impairment and then 
browsing the internet with these ‘spectacles’, including exploration of the accessibility 
features of various websites.  
 
Easily found materials which may be useful include flyscreen mesh off-cuts, fabric netting, 
bubble wrap, tissue paper, cellophane, plastic food wrap and paper with holes cut in to 
simulate tunnel or patchy vision. Although it is important to remember that these materials 
will not accurately simulate specific eye conditions, they can still be useful reminders of how 
much vision impairment, like other disabilities, varies not only in symptoms but in severity 
and significance. 
 
There are number of ways you can choose to use this activity in the classroom such as:  
• Setting up an interactive display which students can use in their spare time (or set it up 

with a number of other interactive displays based on other activities and conduct a lesson 
in which groups of students rotate through different activities) 

• Providing students with light card, scissors, glue, sticky tape and various translucent or 
opaque materials with which to construct their own simulation spectacles for use on 
various websites. 

• Offer a modified activity in which the screens of several computer monitors are covered in 
various materials. Engage students in browsing the internet, trying both sites they know 
well and sites they don’t. 

 
Good websites to include in your test list include:  
Disability Services Commission of Western Australia    
 www.disability.wa.gov.au 
Association for the Blind of WA – including the Accessibility page  
 www.guidedogswa.com.au 
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6.4 Online and Alright 
This activity can be completed during class time but it also makes an ideal and self-contained 
homework task (although it does assume that students have internet access). It is also ideal 
as an extension activity for students who may have finished other work. 
 
It involves a worksheet which asks students to explore and reflect on the visual aspects of 
websites. It is designed to both raise awareness of such features and to reinforce the 
concept that universal design features such as these offer benefits (economic and otherwise) 
across many parts of human society, sighted or not. For example, people who have literacy 
problems such as dyslexia can benefit from audio features. People who care for people with 
a vision impairment can benefit, as can businesses from higher customer numbers. 
 
6.5 Audio Alive 
This activity introduces the concept of “Audio Description” as an example of how accessibility 
can be improved for people who are blind or vision impaired, or who find it difficult to enjoy 
movies and television for other reasons. In an “Audio Described” movie, a narrator provides a 
commentary which is designed to describe and explain the visual content of the movie, such 
as scenery and setting as well as facial expressions and body language. The trick, of course, 
is to manage this without interfering with the soundtrack of the movie itself. 
 
In this activity, students prepare their own audio described script (either in written, audio or 
oral format). 
 
As above, this activity can be completed during class time (with an extract from a pre-
recorded TV program) but it also makes an ideal and self-contained homework task. By 
varying the length and level of detail expected, it can easily be adapted to suit the level at 
which your students are working. 
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Other Suggested Learning Activities 
 
Discussions & Projects  
• Hold a discussion around things we don’t think of as ‘disabilities’ but which nonetheless 

create challenges and to which we have technological responses. For example, small 
children cannot do some things safely so we have invented all sorts of devices to help. 
Discuss left-handedness – what things are more difficult for left-handed people to use. 
Explore with your students the concept that this difficulty is created because the devices 
were designed for right-handed people, not because being left-handed is a disability in 
any sense. 

• Ask your students to spend a week observing devices and technologies used by the 
people they know – and to think of ways these can be made better.  

• With older students you might like to hold a debate (or a series of small debates) about 
the pros and cons of designing prosthetics and bionic devices. For example, you could 
debate whether government money should be invested in helping develop a bionic eye 
ensuring that the students consider the question of whether disabilities are things we 
should try to ‘fix’ at all or whether they are part of the natural diversity of humans. Should 
we try to give everyone the same abilities? An interesting discussion question here is 
“Who decides this?” 

• Engage pairs or small groups of students in role-playing a job interview in which the 
candidate has a vision impairment.  

• Set a ‘speculative fiction’ creative writing task to explore what futuristic technology could 
mean for people who have a disability. 

 

 
Useful Websites 

www.disability.wa.gov.au 
www.assistiveware.com/podcasts.php 
ww.edutopia.org (including www.edutopia.org/technology-visually-impaired-video) 
www.ithaca.edu/wise/topics/educ_students.htm 
www.yourlocalcinema.com.au/about-accessible-cinema 
www.mediaaccess.org.au 

 
 
iTunes & You Tube 
Both of these sites have some freely available resources related to the enabling role that 
technology can play for people living with a disability. We recommend that you explore these 
resources before deciding which to use with your students. 
 
On iTunes you may like to start by exploring the following free podcast series: 
• The Assistive Technology Show 
• Closing the Gap 
• Exploring the frontiers of Assistive Technology 
 
On www.youtube.com you may like to search under the keywords “assistive technology” or 
“adaptive technology” and explore the various video clips available at that time. 

http://www.disability.wa.gov.au/
http://www.assistiveware.com/podcasts.php
http://www.youtube.com/
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Background Reference Material 
 
 
Nobody is sure exactly how many people have a disability but the World Bank estimates 
between 10 and 12% of all people on Earth live with a disability of some kind which interferes 
with the normal tasks of daily living. That’s more than 600 million people. Many (perhaps a 
third) of these are considered to have a severe disability. 
 
 
Terminology 
Language is powerful; the words we choose and how we use them really matters. But there 
isn’t unanimous agreement on the correct language to use when talking about disability. 
Some people, for example, feel that saying ‘people with disabilities’ is better than ‘disabled 
people’ because the person comes first and the disability is not used a label. Others may 
(and do) disagree but in Western Australia, the decision has been made that “people with a 
disability’ is the appropriate phrase or to adapt this to context such as ‘people who are blind 
or vision impaired’. 

Similarly, some people prefer the term ‘visually impaired’ and others ‘vision impaired’ to avoid 
any suggestion that the impairment relates to how someone appears to others but only to 
their own vision capacity. ‘Visually impaired’ is not generally considered acceptable in 
Western Australia.  The phrase ‘the blind’ is considered outdated and unacceptable.  

Prosthetics refers to the production and application of artificial body parts. These may or 
may not replicate body functions. 
 
Bionics refers to using electronics and/or mechanical parts to help people do difficult or 
dangerous things by supplementing or duplicating parts of the body: 
 
Universal Design is the simple idea that we should design and create all buildings, products 
and services so that we maximise the number of potential users and the extent of their use. 
Universal Design should cover a range of abilities, sizes and ages.  
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Examples  - Assistive Technology for People who are Blind or Vision Impaired 
Device or System What it does 

Accessible Mobile Phones Some phones have various features which can be useful 
including a tactile dot on the number 5, large text, colour 
contrast options, large buttons, sound effects, talking menus. 

Braille Translation Software Software programs which translate regular text into Braille 
coding. 

Computer Magnification  Software which allows for text and images to be magnified much 
more than regular software. 

 Video Magnifiers (CCTV) Video devices of various sizes which magnify images – these 
can be useful in different ways than computer magnification. 

Electronic/Refreshable 
Braille Displays 

Electronic devices which display Braille code using tiny metal or 
plastic pins. Used with Braille translation software. 

Electronic Identification 
Devices 

Devices which create and then ‘read’ labels. A popular example 
uses barcode technology to enable people to label large 
numbers of items with barcodes which can then be read with a 
hand-held device. 

Embossing Machines Machines which function much like printers except that instead 
of putting ink on paper, they put impressions on paper. These 
include Braille embossers but also devices which create tactile 
images such as maps and diagrams. 

Portable Computers/ 
Electronic Notetakers 

Various devices can be used for people who are blind or vision 
impaired to take notes by typing into a Braille or regular 
keyboard. Especially useful for students and people attending 
meetings or lectures.  

Portable Reading or 
Playback Devices 

These devices read information from various sources out loud. 
Some need to be used with a computer, others can be used 
independently. 

Print Scanners These are machines which work a little like photocopiers but use 
Optical Character Recognition software to enable the 
information to be turned into a synthesized voice. These are 
especially useful for reading simply designed document such as 
reports, bills, or novels. 

Screen Readers A screen reader works with a voice synthesizer to turn the 
information on a computer screen to audio. 

Talking GPS  The satellite-driven Global Positioning System or GPS allows 
people to have real-time access to information about where they 
are and what is nearby. Talking GPS systems use portable 
notetakers and specialized software to give this information in 
audio format. 
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Relevant Extracts from the Western Australian Curriculum Framework  
Learning Areas and Outcomes information for this kit 
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TECHNOLOGY 
IN SOCIETY 

• Students understand how cultural beliefs, values, abilities and 
ethical positions are interconnected in the development and 
use of Technology and Enterprise. 

• Students evaluate the appropriateness of technologies on 
ethical and moral grounds, as well as considering economic 
advantage and the suitability of products, processes, systems, 
services and environments for individuals and groups at local, 
national and international levels. 

 

SYSTEMS • Students design, adapt and use systems that are appropriate 
to achieving solutions to technology challenges. 

 

PROCESSES • Students apply a technology process to create or modify 
products, processes, systems, services or environments to 
meet human needs and realise opportunities. 
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TIME, 
CONTINUITY 
& CHANGE 

• Students understand that people’s actions and values are 
shaped by their understanding and interpretation of the past. 

• Students recognise that by studying people and events of the 
past, they can better understand the present and make 
informed judgments about the future. They realize that people’s 
ideas and values are influenced by the actions and values of 
those who have come before. 

• Students can, for example, explore the impact of technological 
and economic developments. 
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WRITING 

• Students write for a range of purposes and in a range of forms 
using conventions appropriate to audience, purpose and 
context. 
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New & Improved 
 
Imagine you are in charge of a company that helps other 
people to make their inventions and products better. 
 
 
1. What to do first: Understand the problem 
 
Choose and draw an invention that you know well.  

Label your diagram to show how you think this invention is (or could be) difficult or 
dangerous for someone who is blind or vision impaired to use. 
 
 
2. What to do next: Come up with new ideas 
Think of ways to make it easier or safer for someone who is blind or vision impaired 
to use. 
 

How could you change the things that are a problem now? 
 
Are there other new features that could make it even easier and safer 
to use? 
 

 
List or draw your ideas. 
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3. What to do last: Make a decision  
 

Which of your ideas would be most 
helpful to people who are blind or vision 
impaired? 

Which of your ideas could also be useful 
for people who aren’t blind or vision 
impaired? 

 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
 

 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
……………………………………………… 
 
 

 
 
 
Which ideas do you think are best for your company to develop? Why? 
 
…………………………………………………..………………………………………………….. 
 
…………………………………………………..………………………………………………….. 
 
…………………………………………………..………………………………………………….. 
 
…………………………………………………..………………………………………………….. 
 
…………………………………………………..………………………………………………….. 
 
…………………………………………………..………………………………………………….. 
 
…………………………………………………..………………………………………………….. 
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Double Bonus Ideas 
 
Some ideas and inventions can be useful in more ways than their 
inventor first t
 
For example, some things invented for sighted people can be useful for 
people living with blindness, too, and many things invented for people 

who are vision impaired can also be useful for people who are fully sighted. 
 
 
For each one of these inventions, write at least one task for which it could be useful to 
someone who is blind or vision impaired and one for someone who is fully sighted. 
 
 

Sticker Dots Colour-

Detector 

Textured 

Clothes Labels 

 

 

Magnifying 

Glass 

 

Audio Software

Satellite 

Navigation 

 

Bar Codes & 

Scanners 

Bumpy Paving 

Stones 

 

 

 

Voice 

Synthesizer 

Puff Paint 
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Simulated Surfing 
 
Imagine what it’s like to surf the internet if you are blind or vision 
impaired. It probably seems difficult or impossible but it’s not at all!  
 
You might be surprised at how many clever ideas are helping make 
the internet friendlier and more useful for people living with vision 
impairment. 
 
1.  Browsing with a difference 
 
Using sets of spectacles made of various materials, explore several websites. 
 
Site URL What is it like to visit without your normal vision? 

  

  

  

  

  

 
2. Try Again with Tricks Up Your Sleeve 
 
Read the Common Accessibility Features information. 
Now explore the sites above again - as well as some new ones. 
 
Site URL What accessibility features do you find most useful and why? 
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Common Website Accessibility Features 

Recent versions of Microsoft Windows, Apple operating system (Mac OS) and Linux 
contain many accessibility features that can assist people who are blind or vision 
impaired. 
   
 
Adjusting the text size: 
 
Internet Explorer – Windows 98/ME/2000/XP 
Go to the ‘View’ pull-down menu and go to ‘Text Size’  
 
A pop-up menu should appear showing you five different text sizes. Select ‘Larger’ or 
‘Largest’ to make the text larger. This will also increase the size on many other sites. 
 
Internet Explorer - Windows Vista/7 
Hold down the CTRL key on your keyboard. Press the ‘+’ key to make the text bigger 
or the ‘-’ key to make the text smaller. Keep repeating step 2 until the text is at a 
suitable size.  
 
Safari – Mac OS 
Hold down the ‘Apple’ key and press the ‘+’ key. Repeat until the text is at a suitable 
large. 
 
Firefox – Windows (all), Mac OS, Linux 
Hold down the CTRL key on your keyboard. Press the ‘+’ key to make the text bigger 
or the ‘-’ key to make the text smaller. Keep repeating step 2 until the text is at a 
suitable size.  
  
 
Adjusting the Colour Contrast: 
 
Internet Explorer – Windows 98/ME/2000/XP/Vista/7 
Go to the ‘Tools’ pull-down menu and select ‘Internet Options’. In the bottom-left 
hand corner you will see a ‘Colors’ button.  Select this button and choose the colours 
you want then click OK on the ‘Colors’ and ‘Internet Options’ screen.  
 
Safari – Mac OS 
The easiest way to change the colours is to use the built-in ‘reverse’ feature in Mac 
OS 10.4 Tiger or higher. This will reverse all colours on the screen. This option can 
be selected by holding down the ‘CTRL’, ‘Option’ and ‘Apple’ keys while pressing the 
number ‘8’. Repeat step 1 to change the colours back to normal.  
 
Firefox – Windows (all), Mac OS, Linux 
Go to Options > Content > Colour to change the colour settings. 
 
 



Guide Dog Discovery Centre 
Mission 6: Technology Help 

Worksheet 6.3 

© 2009 Association for the Blind of Western Australia  Exceptions: Images © Microsoft Office Clip Art 

 
 
 
Text-to-Speech Access: 
 
Windows 98/2000/XP/Vista/7: 
You can purchase an additional software program such as JAWS that will allow your 
computer to read web pages to you aloud.  
 
Mac OS: 
Mac OS 10.4 Tiger and higher have a built-in program called VoiceOver which can 
read aloud text on your computer screen, including web pages. To turn on 
VoiceOver, hold down the ‘Apple’ key and press the ‘F5’ key. Further information 
about VoiceOver can be obtained from Apple web site www.apple.com 
 
Linux  
Linux Operating Systems such as Ubuntu, Suse and Fedora have a built-in program called 
Orca which, like VoiceOver, can read aloud text on your computer screen including web 
pages. It also has a built in magnifier and the ability to change colour contrast. More 
information about Orca is at http://live.gnome.org/orca 

http://www.apple.com/
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Audio Alive 
 
Lots of cool inventions have been created to make things better for people who 
are living with a disability (many of them have been created by people who 
have a disability themselves!). 
 
One of these clever ideas is “Audio Described” movies and television. Try 
creating some for yourself. 
 

 
What to do 
 
Choose one section of a movie or television program. Prepare a description of what is 
happening for someone who is blind.  
 
……………………………………………………………………………………………………..…

………………………………………………………………………………………………………. 

……………………………………………………………………………………………………..…

………………………………………………………………………………………………………. 

……………………………………………………………………………………………………..…

………………………………………………………………………………………………………. 

……………………………………………………………………………………………………..…

………………………………………………………………………………………………………. 

……………………………………………………………………………………………………..…

………………………………………………………………………………………………………. 

……………………………………………………………………………………………………..…

………………………………………………………………………………………………………. 

……………………………………………………………………………………………………..…

………………………………………………………………………………………………………. 

……………………………………………………………………………………………………..…

………………………………………………………………………………………………………. 
 
 
 Things to remember: 

 Your audience will want to hear the soundtrack, the actors speaking and 
any sound effects.  

 Your description should stick only to what you can see. 
 Keep it short … and don’t talk over the top of the good bits!  
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Online and Alright 
 
 
More software packages and websites are now being designed with features for 
people who are blind or vision impaired.  
 
Here are some examples: 
 

 Text enlargement 
 Audio (built-in sound recording that reads something out loud) 
 Text-only options 
 Options to change colour contrast 

 
What to do  
 
Visit a variety of websites until you have found at least five with features designed for people who 
are blind or vision impaired. Complete the table below. 
 

Website Address Whose website is it? What is it about? What features does it have? 

   

   

   

   
 
 

Blindness and vision loss are the most common type 
of disability in the world. Although nobody knows the 
exact numbers, many millions of people live with 
blindness and vision loss every day.  
 
This means that any new ideas which can help 
people who are blind have plenty of potential 
customers! And many of these ideas can be useful 
for sighted people, too. 
 

 



Guide Dog Discovery Centre 
Mission 6: Technology & Other Good Ideas 

Worksheet 6.5  

© 2009 Association for the Blind of Western Australia  Exceptions: Images © Microsoft Office Clip Art 

 
 
 
Make a list of groups of people who could benefit from these features, and why this 
matters (we have started you off). 
 

Group of people who could 
benefit 

Types of benefits 

People who are blind or have a 

vision impairment  
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